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Getting to Know  
Microsoft Office Versions 
Cengage is proud to bring you the next edition of Microsoft Office. This 
edition was designed to provide a robust learning experience that is not 
dependent upon a specific version of Office.

Microsoft supports several versions of Office: 

•	Office 365: A cloud-based subscription service that delivers 
Microsoft’s most up-to-date, feature-rich, modern productivity tools 
direct to your device. There are variations of Office 365 for business, 
educational, and personal use. Office 365 offers extra online storage 
and cloud-connected features, as well as updates with the latest 
features, fixes, and security updates.

•	Office 2021: Microsoft’s “on-premises” version of the Office apps, 
available for both PCs and Macs, offered as a static, one-time 
purchase and outside of the subscription model. 

•	Office Online: A free, simplified version of Office web applications 
(Word, Excel, PowerPoint, and OneNote) that facilitates creating and 
editing files collaboratively. 

Office 365 (the subscription model) and Office 2021 (the one-time pur-
chase model) had only slight differences between them at the time this 
content was developed. Over time, Office 365’s cloud interface will con-
tinuously update, offering new application features and functions, while 
Office 2021 will remain static. Therefore, your onscreen experience may 
differ from what you see in this product. For example, the more advanced 
features and functionalities covered in this product may not be available 
in Office Online or may have updated from what you see in Office 2021. 

For more information on the differences between Office 365, Office 2021, 
and Office Online, please visit the Microsoft Support site. 

Cengage is committed to providing high-quality learning solutions for 
you to gain the knowledge and skills that will empower you throughout 
your educational and professional careers.

Thank you for using our product, and we look forward to exploring the 
future of Microsoft Office with you! 
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Using SAM Projects  
and Textbook Projects
SAM Projects allow you to actively apply the skills you learned live in 
Microsoft Word, Excel, PowerPoint, or Access. Become a more productive 
student and use these skills throughout your career.

To complete SAM Textbook Projects, please follow these steps:

SAM Textbook Projects allow you to complete a project as you follow 
along with the steps in the textbook. As you read the module, look for 
icons that indicate when you should download  your SAM Start 
file(s) and when to upload  the final project file to SAM for grading.

Everything you need to complete this project is provided within SAM. 
You can launch the eBook directly from SAM, which will allow you to take 
notes, highlight, and create a custom study guide, or you can use a print 
textbook or your mobile app.  Download IOS or Download Android.

To get started, launch your SAM Project assignment from SAM, MindTap, 
or a link within your LMS.

Step 1: Download Files

	 •	 Click the “Download All” button or the individual links to download 
your Start File and Support File(s) (when available). You must use 
the SAM Start file. 

	 •	 Click the Instructions link to launch the eBook (or use the print 
textbook or mobile app).

	 •	 Disregard any steps in the textbook that ask you to create a new 
file or to use a file from a location outside of SAM.  

	 •	 Look for the SAM Download icon  to begin working with your 
start file.

	 •	 Follow the module’s step-by-step instructions until you reach the 
SAM Upload icon .

	 •	 Save and close the file.
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Step 2: Save Work to SAM

	 •	 Ensure you rename your project file to match the Expected File 
Name.

	 •	 Upload your in-progress or completed file to SAM. You can down-
load the file to continue working or submit it for grading in the 
next step. 

Step 3: Submit for Grading 

	 •	 Upload the completed file to SAM for immediate feedback and to 
view the available Reports.

	 •	 The Graded Summary Report provides a detailed list of project 
steps, your score, and feedback to aid you in revising and re-
submitting the project.

	 •	 The Study Guide Report provides your score for each project 
step and links to the associated training and textbook pages.

	 •	 If additional attempts are allowed, use your reports to assist with 
revising and resubmitting your project.

	 •	 To re-submit the project, download the file saved in step 2. 

	 •	 Edit, save, and close the file, then re-upload and submit it again. 

For all other SAM Projects, please follow these steps:

To get started, launch your SAM Project assignment from SAM, MindTap, 
or a link within your LMS.

Step 1: Download Files

	 •	 Click the “Download All” button or the individual links to download 
your Instruction File, Start File, and Support File(s) (when  
available). You must use the SAM Start file.

	 •	 Open the Instruction file and follow the step-by-step instructions. 
Ensure you rename your project file to match the Expected File 
Name (change _1 to _2 at the end of the file name).

Step 2: Save Work to SAM

	 •	 Upload your in-progress or completed file to SAM. You can down-
load the file to continue working or submit it for grading in the 
next step.

Using SAM Projects and Textbook ProjectsSAM-2
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Step 3: Submit for Grading

	 •	 Upload the completed file to SAM for immediate feedback and to 
view available Reports.

	 •	 The Graded Summary Report provides a detailed list of project 
steps, your score, and feedback to aid you in revising and  
resubmitting the project.

	 •	 The Study Guide Report provides your score for each project 
step and links to the associated training and textbook pages.

	 •	 If additional attempts are allowed, use your reports to assist with 
revising and resubmitting your project.

	 •	 To re-submit the project, download the file saved in step 2. 

	 •	 Edit, save, and close the file, then re-upload and submit it again. 

For additional tips to successfully complete your SAM Projects, please 
view our Common Student Errors Infographic.
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WD 1–1

Module 1
Objectives

Session 1.1
•	Create and save a document
•	Enter text and correct errors as 

you type
•	Use AutoComplete and 

AutoCorrect
•	Select text and move the 

insertion point
•	Undo and redo actions
•	Adjust paragraph spacing, line 

spacing, and margins
•	Preview and print a document
•	Create an envelope

Session 1.2
•	Open an existing document
•	Use the Editor pane
•	Change page orientation, font, 

font color, and font size
•	Apply text effects and align text
•	Copy formatting with the 

Format Painter
•	Insert a paragraph border and 

shading
•	Delete, insert, and edit a photo
•	Add a page border
•	Create bulleted and numbered 

lists
•	Use Microsoft Word Help

Creating and 
Editing a 
Document
Writing a Business Letter and 
Formatting a Flyer

Case | Water Resources Department
David Alzacar is the communications director for the Water 
Resources Department in Portland, Oregon. As part of his outreach 
efforts, he has produced a set of brochures promoting the city’s 
water conservation efforts. David has asked you to create a cover 
letter to accompany the brochures he is sending to the organizers 
of a national sustainability conference. He has also asked you 
to create an envelope for sending a water quality report to an 
environmental engineering publication. Next, he wants your 
help creating a flyer encouraging community members to join a 
citizen advisory panel. Finally, he would like to add bulleted and 
numbered lists to the minutes of a recent advisory panel meeting.

You will create the letter and flyer using Microsoft Word 365 (or 
simply Word), a full-featured word processing app that lets you create 
professional-looking documents and revise them easily. You’ll start by 
opening Word and saving a new document. Then you’ll type the text 
of the cover letter and print it. In the process of entering the text, you’ll 
learn several ways to correct typing errors and how to adjust paragraph 
and line spacing. When you create the envelope, you’ll learn how to 
save it as part of a document for later use. As you work on the flyer, 
you will learn how to open an existing document, change the way 
text is laid out on the page, format text, add a page border, and insert 
and resize a photo. Finally, you’ll add bulleted and numbered lists to a 
document, and then learn how to use Microsoft Word Help.

Starting Data Files

Word1 Module

NP_WD_1-1.docx
NP_WD_1-2.docx
Support_WD_1_Water.png

Review

NP_WD_1-3.docx
NP_WD_1-4.docx
Support_WD_1_Glass.png

Case1

(none)

Case2

NP_WD_1-5.docx
Support_WD_1_Sign.jpg
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Session 1.1 Visual Overview: 

You can choose to display the
rulers, which help you position
elements in a document.

Buttons for related commands
are organized on a tab in
groups. The buttons in this
group can be used to change
the appearance of a paragraph.

The status bar provides
information about the
current document, such as
the current page and
number of words in the
document; it also contains
buttons and other
controls for working with
the document.

The paragraph mark indicates the end
of a paragraph. It is visible only if
nonprinting characters are turned on.
Nonprinting characters appear on the
screen but not on the printed page.

The insertion point shows
where characters will appear
when you start typing.

The ribbon is the main set of
buttons and other tools you
can use to complete tasks.
It is organized into tabs and
groups.

The Quick Access Toolbar is
a collection of buttons that
provides one-click access to
commonly used commands,
such as Save, Undo, and
Repeat; you might see
additional buttons here.

Each tab includes commands related
to particular activities or tasks. The
Home tab includes options for
formatting and editing text.

The title bar displays
the name of the open
file and the program.

The dark gray areas on the ruler 
represent the document’s margins. 
Margins are the blank spaces around 
the edges of a document’s content.
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The Word Window
You can click the Ribbon Display Options button
to display a menu with options for how the
ribbon looks. If the ribbon is hidden, click Show
Tabs and Commands in this menu to redisplay it.

You use the Minimize button
to reduce the Word window
to an icon in the taskbar,
which you can click later to
display the Word window
again.

You use the Restore Down
button to reduce the Word
window to a smaller size; the
Restore Down button is then
replaced with the Maximize
button, which you can click
to restore the Word window
to its full size.

You can click the scroll
arrows to scroll up or down
one line, or hold the mouse
button to scroll up or down
more quickly.

If you are signed in, your
name appears here as a
link that you can click to
access information about
your Microsoft account.

You can drag the scroll box 
up or down to see other 
parts of a document.

Zooming magnifies or shrinks
the display of the content in
the Word window. To quickly
change the Zoom level, drag
the slider button left or right
on the Zoom slider.

The View buttons allow
you to change the way the
document is displayed.Print Layout view, the default

view, most closely resembles
how your document will look
when printed.

The Show/Hide button is
selected, meaning that
nonprinting characters are
displayed in the document.
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Starting Word
With Word, you can quickly create polished, professional documents. You can type a 
document, adjust margins and spacing, create columns and tables, add graphics, and 
then easily make revisions and corrections. In this session, you will create one of the 
most common types of documents—a block-style business letter.

To begin creating the letter, you first need to start Microsoft Word and then set up the 
Word window.

To start Word:
◗	 1.	  On the Windows taskbar, click the Start button  . The Start menu 

opens.

◗	 2.	 On the Start menu, scroll the list of apps, and then click Word. Word starts 
and displays the Recent screen in Backstage view. Backstage view provides 
access to various screens with commands that allow you to manage files and 
Word options. See Figure 1–1.

◗	 3.	 Click Blank document. The Word window opens, with the ribbon displayed. 

Trouble?  If you don’t see the ribbon, click the Ribbon Display Options 
button  , as shown in the Session 1.1 Visual Overview, and then click Show 
Tabs and Commands.

Don’t be concerned if your Word window doesn’t match the Session 1.1 
Visual Overview exactly. You’ll have a chance to adjust its appearance 
shortly.

Figure 1–1	 Recent screen in Backstage view

click to open a new,
blank document

a list of recently
opened documents
might appear here

your list of available
templates may differ
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Working in Touch Mode
You can interact with the Word screen using a mouse, or, if you have a touchscreen, 
you can work in Touch Mode, using a finger instead of the pointer. In Touch Mode, 
extra space around the buttons on the ribbon makes it easier to tap the specific 
button you need. The figures in this text show the screen with Mouse Mode on, 
but it’s helpful to learn how to switch back and forth between Touch Mode and 
Mouse Mode.

Note: The steps in this module assume that you are using a mouse. If you are instead 
using a touch device, please read these steps but don’t complete them so that you 
remain working in Touch Mode.

To switch between Touch and Mouse Mode:
◗	 1.	 On the Quick Access Toolbar, click the Customize Quick Access Toolbar 

button  to open the menu. The Touch/Mouse Mode command near the 
bottom of the menu does not have a checkmark next to it, indicating that it 
is currently not selected.

Trouble?  If the Touch/Mouse Mode command has a checkmark next to it, 
press ESC to close the menu, and then skip to Step 3.

◗	 2.	 On the menu, click Touch/Mouse Mode. The menu closes, and the  
Touch/Mouse Mode button  appears on the Quick Access Toolbar.

◗	 3.	 On the Quick Access Toolbar, click the Touch/Mouse Mode button  . 
A menu opens with two options—Mouse and Touch. The icon next to Mouse 
is shaded gray to indicate it is selected.

Trouble?  If the icon next to Touch is shaded gray, press ESC to close the 
menu and skip to Step 5.

◗	 4.	 On the menu, click Touch. The menu closes, and the ribbon increases in 
height so that there is more space around each button on the ribbon. See 
Figure 1–2.

Trouble?  If you are working with a touchscreen and want to use Touch 
Mode, skip Steps 5 and 6.

◗	 5.	 On the Quick Access Toolbar, click the Touch/Mouse Mode button  , and 
then click Mouse. The ribbon changes back to its Mouse Mode appearance, 
as shown in the Session 1.1 Visual Overview.

Figure 1–2	 Word window in Touch Mode 

Touch/Mouse Mode
button

Customize Quick
Access Toolbar button

expanded ribbon, with
buttons farther apart
than in Mouse Mode

insertion point
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To set up your Word window to match the figures in this book:
◗	 1.	 If the Word window does not fill the entire screen, click the Maximize button 

 in the upper-right corner of the Word window.

The insertion point on your computer should be positioned about an inch 
from the top of the document, as shown in Figure 1–2, with the top margin 
visible.

Trouble?  If the insertion point appears at the top of the document, with no 
white space above it, position the pointer between the top of the document 
and the horizontal ruler, until it changes to  , double-click, and then scroll 
up to top of the document.

◗	 2.	 On the ribbon, click the View tab. The ribbon changes to show options for 
changing the appearance of the Word window.

◗	 3.	 In the Show group, click the Ruler check box to insert a checkmark, if 
necessary. If the rulers were not displayed, they are displayed now.

Next, you’ll change the Zoom level to a setting that ensures that your Word 
window will match the figures in this book. To increase or decrease the 
screen’s magnification, you could drag the slider button on the Zoom slider 
in the lower-right corner of the Word window. But to choose a specific Zoom 
level, it’s easier to use the Zoom dialog box.

◗	 4.	 In the Zoom group, click the Zoom button to open the Zoom dialog box. 
Double-click the current value in the Percent box to select it, type 120, and 
then click OK to close the Zoom dialog box.

◗	 5.	 On the status bar, click the Print Layout button  to select it, if necessary. 
As shown in the Session 1.1 Visual Overview, the Print Layout button is the 
middle of the three View buttons located on the right side of the status 
bar. The Print Layout button in the Views group on the View tab is also 
now selected.

Changing the Zoom level 
affects only the way the 
document is displayed 
on the screen; it does not 
affect the document itself.

Tip

Before typing a document, you should make sure nonprinting characters are 
displayed. Nonprinting characters provide a visual representation of details you might 
otherwise miss. For example, the (¶) character marks the end of a paragraph, and the 
(•) character marks the space between words.

◗	 6.	 On the Quick Access Toolbar, click the Customize Quick Access Toolbar 
button  , and then click Touch/Mouse Mode to deselect it. The  
Touch/Mouse Mode button is removed from the Quick Access Toolbar.

Setting Up the Word Window
Before you start using Word, you should make sure you can locate and identify 
the different elements of the Word window, as shown in the Session 1.1 Visual 
Overview. In the following steps, you’ll make sure your screen matches the Visual 
Overview.
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Saving a Document
Before you begin working on a document, you should save it with a new name. When 
you click the File tab and then click Save to save a document for the first time, Word 
displays the Save As screen in Backstage view. On the Save As screen, you can select 
the location where you want to store your document. After that, you can click the Save 
button on the Quick Access Toolbar to save your document to the same location you 
specified earlier and with the same name.

To save the document:
◗	 1.	 Click the File tab on the ribbon, and then click Save. Word switches to the 

Save As screen in Backstage view, as shown in Figure 1–3.

Because a document is now open, more commands are available in 
Backstage view than when you started Word. The navigation pane on 
the left contains commands for working with the open document and for 
changing settings that control how Word works.

◗	 2.	 Click the Browse button. The Save As dialog box opens.

To verify that nonprinting characters are displayed:
◗	 1.	 On the ribbon, click the Home tab.

◗	 2.	 In the blank Word document, look for the paragraph mark (¶) in the first line 
of the document, just to the right of the blinking insertion point.

Trouble?  If you don’t see the paragraph mark, click the Show/Hide ¶ button
 in the Paragraph group.

In the Paragraph group, the Show/Hide ¶ button should be highlighted in 
gray, indicating that it is selected, and the paragraph mark (¶) should appear 
in the first line of the document, just to the right of the insertion point.

Figure 1–3	 Save As screen in Backstage view

navigation pane

Save As
selected in the
navigation pane

click to open the
Save As dialog
box

you might see additional folders here; if you want to save
a document in a folder that is listed here, click the folder
to open the Save As dialog box with that folder selected

click to return to
the document
window

To save a document to 
OneDrive for the first 
time, you can click the 
Save button on the Quick 
Access Toolbar.

Tip
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◗	 4.	 Click the File name box, and then type NP_WD_1_Letter. The text you type 
replaces the selected text in the File name box.

◗	 5.	 Click Save. The file is saved, the dialog box and Backstage view close, and 
the document window appears again, with the new file name in the title bar. 

Now that you have saved the document, you can begin typing the letter. David has 
asked you to type a block-style letter to accompany some water conservation brochures 
that will be sent to Carla Zimmerman. Figure 1–5 shows the block-style letter you will 
create in this module.

Trouble?  If your instructor wants you to save your files to your OneDrive 
account, click OneDrive, and then log in to your account.

◗	 3.	 Navigate to the location specified by your instructor. The default file name, 
“Doc1,” appears in the File name box. You will change that to something 
more descriptive. See Figure 1–4.

Figure 1–4	 Save As dialog box

default file name

you might see
something different
here, depending
on the location
specified by your
instructor
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Figure 1–5	 Completed block-style letter

Water Resources Department

9088 Woodhouse Avenue

Portland, Oregon 97204

www.water.portland.cengage.com

Water
Resources

Department

entire letter 
aligned along 
left margin

indicates the letter 
has something 
accompanying it

date

inside address

salutation

body

complimentary close

signature and 
title lines

typist’s initials

Written Communication: Creating a Business Letter

Several styles are considered acceptable for business letters. The main differences 
among the styles have to do with how parts of the letter are indented from the left 
margin. In the block style, which you will use in this module, each line of text starts at 
the left margin. In other words, nothing is indented. Another style is to indent the first 
line of each paragraph. The choice of style is largely a matter of personal preference, 
or it can be determined by the standards used in a particular business or organization. 
To further enhance your skills in writing business correspondence, you should consult 
an authoritative book on business writing that provides guidelines for creating a 
variety of business documents, such as Business Communication: Process & Product 
by Mary Ellen Guffey and Dana Loewy.

Proskills

this is the 
department’s 
letterhead; it will 
not appear in the 
document you 
work on in Word
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To insert the date:
◗	 1.	 Type Febr (the first four letters of “February”). A ScreenTip appears above the 

letters, as shown in Figure 1–6, suggesting “February” as the complete word.

A ScreenTip is a label with descriptive text or an explanation about what to 
do next.

If you wanted to type something other than “February,” you could 
continue typing to complete the word. In this case, you want to accept the 
AutoComplete suggestion.

◗	 2.	 Press Enter. The rest of the word “February” is inserted in the document. Note 
that AutoComplete works for long month names like February but not shorter ones 
like May, because “Ma” could be the beginning of many words besides “May.”

◗	 3.	 Press SPACEBAR, type 1, 2025 and then press Enter twice, leaving a blank 
paragraph between the date and the line where you will begin typing the 
inside address, which contains the recipient’s name and address. Notice the 
nonprinting character (•) after the word “February” and before the number 
“1,” which indicates a space. Word inserts this nonprinting character every 
time you press SPACEBAR.

Trouble?  If February happens to be the current month, you will see a 
second AutoComplete suggestion displaying the current date after you press 
SPACEBAR. To ignore that AutoComplete suggestion, continue typing the 
rest of the date, as instructed in Step 3.

Entering Text
The letters you type in a Word document appear at the current location of the blinking 
insertion point.

Inserting a Date with AutoComplete
The first item in a block-style business letter is the date. David plans to send the letter 
to Carla on February 1, so you need to insert that date into the document. To do so, you 
can take advantage of AutoComplete, a Word feature that automatically suggests dates 
and other regularly used items for you to insert. In this case, you can type the first few 
characters of the month and let Word insert the rest.

Figure 1–6	 AutoComplete suggestion

ScreenTip tells you
how to enter the rest
of the word “February”
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